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QuarkXPress 2019 (v15.2) 

Features and Enhancements 

This document provides an introduction to new features and enhancements in 

QuarkXPress 2019 (v15.2). 

Text and Typography •

New option for Space before Paragraph •

Specify Last Line Indent for a Paragraph  •

User Interface •

Dark Theme on Windows  •

Keyboard shortcuts for Style sheet Context Menu •

Digital Publishing •

Performance Improvements in Flex Layouts •

Graphics •

Preserve TTF used in layout and in PDF files as TTF in PDG output. •

IDML Enhancements •

InDesign File Import Enhancements  •

Text and Typography 

New Option for Space Before Paragraph 

Users now have an option to apply Space Before to the first paragraph in a column 

or a text box via Paragraph Style Sheets as well as Measurement Palette. Earlier, 

Space Before could be applied only between paragraphs. 

This will help designers since they can now apply space before to the very first 

paragraph of the column and also maintain the same spacing across all paragraphs. 

Space before options: 

Only between paragraphs: This applies space before only between paragraphs 1.

and hence is not applicable for the very first paragraph of the column. Earlier, 

users had to manually insert for space in the very first paragraph of the column. 
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Only at Column Top: This applies space before to the very first paragraph of 2.

the column. 

Always: As the name implies it applies to both the above scenarios. 3.

Measurement Palette 

 

Measurement Palette 

Style Sheet 
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Style Sheet 

Specify Last Line Indent for a Paragraph 

The Last line indent can be set for paragraphs via Paragraph Style Sheets as well as 

Measurement Palette. This helps the text in the last line of a paragraph to flow to 

the right indent area and allows user to handle multiple use cases like creating a 

Table of Content or some other content where the relevant text for each paragraph 

in the last line needs to be added to the right indent area.  For example: 

Questionnaire with multiple choice answers or True or False statements. 

 

Specify Last Line Indent for a Paragraph 
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Paragraph Style Sheet 

  

Use Cases for Last line Indent 

 

Use Case for Last Line Indent 1 

  

 

Use Case for Last Line Indent 2 

User Interface  

Dark Theme on Windows  

Experience the richness of modern dark theme for the application canvas, 

document canvas and palettes. Rich look comes with more stable palettes and 

seamless UI experience while working on documents. 

The Dark theme is now the default theme of QuarkXPress. 

To change the color theme, Click on Edit-> Preferences-> Color Theme 
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The change in color theme will take after relaunching the QuarkXPress application. 

Keyboard Shortcuts for Style sheet Context Menu 

Style sheet context menu options may be accessed with new Keyboard shortcuts for 

user convenience and to improve productivity.  
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Digital Publishing 

Performance Improvements in Flex Layouts  

For improved user experience with Flex layouts, significant performance •

improvement has been made in the area of panning and scrolling in Flex Layout 

Pages. 

Faster scrolling and panning of Flex layout and no lag while user input text. •

Optimization for exported images, without losing the quality of the image, the •

image size is reduced while generating HTML5 output. Page loading will be faster 

since the output size is lesser. 

Graphics 

Preserve TTF Used in Layout and in PDF Files as TTF in PDG Output 

TrueType Fonts used in QuarkXPress project and also in imported PDF till now 

outputting as Type1 on outputting PDF from QuarkXPress. From now, TrueType 

Fonts used in QuarkXPress project and also in imported PDF will be retained as 

TrueType Fonts on outputting as PDF from QuarkXPress. 

This may fail some times if the TrueType Fonts breach the 64K limit of PostScript 

strings, in this case TrueType Fonts will output as Type1 as before. 

IDML Enhancements 

InDesign File Import Enhancements  

Earlier, while importing IDML file in QuarkXPress, the Footnotes, Endnotes in the 

IDML file and Drop shadow effects associated with an item were ignored. Now, 

QuarkXPress 15.2, provides support for importing of footnotes, endnotes as well as 

drop shadow effects from IDML file. 

This will help designers in productivity and save their time as they do not have to 

add these features manually. 

In IDML import, Endnotes applied at the “document” level cannot be imported in 
QuarkXPress. (QuarkXPress only provides support for endnotes applied at story 

level)
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Features and Enhancements 

This document provides an introduction to new features and enhancements in 

QuarkXPress 2019 (v15.1). 

Text and Typography •

Export Endnotes as Hyperlinks •

Last Line Indent in Table of Contents •

Copy-Paste Text Content Along with Formatting from External Applications to •

QuarkXPress 

Performance Improvements in Different Font–related Functions in QuarkXPress On •

Windows OS 

Performance Improvements in Text Rendering •

InDesign File Import •

Convert InDesign files to QuarkXPress Projects •

Table Styles Enhancement in IDML Import •

Design Features •

Integration of Custom Border Styles with Item Styles and Item Find/Change •

Integration of Auto Grow Text Boxes in Item Styles •

Integration of Heterogeneous Borders in Item Styles •

Tables •

Improved Integration with Master Pages •

Continued Table Headers •

Graphics •

Enhancements of Color Editing •

Improvements in EPS Images •

Spring Loading Progress Bar •

Digital Publishing •
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Flex Layouts •

Usability Improvements •

Palette Sets and Usability Issues •

  

  

Text and Typography 

  

Export Endnotes as Hyperlinks 

What Is It?  

A QuarkXPress document can contain footnotes or endnotes or both. Footnote text 

is displayed in the footnote marked area, whereas the endnotes are displayed at the 

end of the document. Prior to QuarkXPress 2019 (v15.1), whenever a user exported 

a document as pdf having endnotes and viewed the output, he had to always 

manually navigate to the end of the document to view each of the Endnote texts. 

QuarkXPress 2019 (v15.1) includes a new option to export endnotes in the 

document as hyperlinks during PDF export. 

Where Is It?  

 

Export Endnotes as Hyperlinks 
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To export endnotes as hyperlinks, invoke Export as PDF dialog > Click Options > Go 

to Hyperlinks pane > Check ‘Export Endnotes as Hyperlinks’. You can define 

different hyperlink appearance options for the endnotes. 

Similarly, you can define the export endnotes as hyperlink settings in the PDF 

Output Styles dialog. 

Last Line Indent in Table of Contents 

What Is It?  

Prior to QuarkXPress 2019 (v15.1), while building Table for Contents (TOC), it was 

not possible to define an indent spacing specifically for page numbers. As a result, if 

the Table of Contents contained multi-line chapter/section headings, the page 

number would wrap below the heading. 

 

Last Line Indent in Table of Contents 

In QuarkXPress 2019 (v15.1), you can define an indent spacing specifically for page 

numbers in the Table of Contents. 

Where Is It?  

There is no separate user interface control for the Last Line Indent. To define last 

line indent, you can specify a Right Indent value in the paragraph style sheet. While 

building the TOC, the right line indent value will be treated as the Last Line Indent. 

Only page numbers will be allowed in the Last Line Indent spacing. This setting is 

only applicable for Table of Contents. 

Copy-Paste Text Content Along with Formatting from External 
Applications to QuarkXPress 

What Is It?  

While copy-pasting text content from any external application like Microsoft Word, 

Word Pad, Text Edit, etc., Only the text was copied sans any formatting and was 

pasted in QuarkXPress as plain text. 

In QuarkXPress 2019 (v15.1), you can copy-paste text content from any external 

application with the same formatting. It is only applicable if the external 

application writes to the clipboard using the RTF format. 

What Is It Good For?  
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In QuarkXPress 2019 (v15.1), while copy-pasting text content from any external 

application, the following attributes will be retained: Text formatting (font, font 

style, text style, color, indents, spacings, etc.), Tables, Footnotes, etc. In case you 

wish to paste text from an external application as plain text, you can use Paste 

without Formatting option. 

Performance Improvements in Different Font–related Functions in 
QuarkXPress On Windows OS 

What Is It?  

There were some performance issues with font-related functions in QuarkXPress on 

Windows OS. There was a performance delay while changing the font and font style 

using the measurement palette as well as in invoking and switching fonts in Glyph 

palette. Also, there was a performance delay in invoking Preferences dialog, 

Character style sheet dialog, Measurement palette, and Switching tabs in 

measurement palette. There was a performance delay if the Most Recently Used font 

setting was enabled. 

What Is It Good For?  

There will be no performance delay while changing the font and font style using 

the measurement palette in Windows OS. There will be no performance delay in 

invoking and switching fonts in Glyph palette on Windows OS as well as in 

invoking Preferences dialog, Character style sheet dialog, Measurement palette, and 

Switching tabs in measurement palette on Windows OS. Moreover, there will be no 

performance delay if the Most Recently Used font setting is enabled on Windows 

OS. The default value of Maximum Number of Recently used fonts has been 

reverted to 5 on Windows OS. 

Performance Improvements in Text Rendering 

QuarkXPress 2019 (v15.1) onward, Graphic Cards will be used for text rendering 

i.e., Hardware Accelerated Text Rendering, while working with QuarkXPress projects 

having text. 

What to expect? 

General Text Rendering. 1.

Scrolling and Panning of projects having lots of text. The performance of such 2.

projects is enhanced. 

Convert InDesign files to QuarkXPress Projects 

  

Open Single InDesign Files in QuarkXPress 

Prior to QuarkXPress 2019 (v15.1), you can only open IDML files through File menu 

> Open Dialog in QuarkXPress. In QuarkXPress 15.1, you can now also open INDD 

files through File menu > Open Dialog in QuarkXPress. 
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Bulk Conversion of InDesign Files to QuarkXPress Projects 

In QuarkXPress 2019 (v15.1), you can convert your InDesign files (both IDML and 

INDD) seamlessly to QuarkXPress projects. There are multiple options to 

automatically search InDesign files by running a Smart Scan for Bulk conversion or 

you can Browse individual files for conversion. You can also select/deselect 

individual files for conversion. 

How it Works? 

The Convert InDesign files dialog will appear automatically after a fresh 1.

QuarkXPress installation. Alternatively, users can also invoke the Convert 

InDesign files dialog from the Help menu > Convert InDesign Files. 

 

  

Convert InDesign files dialog will appear and user needs to select the option to 2.

convert files.  

 

User needs to click on Run Smart Scan or Manually Select files. 
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After the scan, all the INDD & IDML files will display and the user can select all 3.

files or select only few for conversion before clicking on Convert Selected 

button. 

 

  

After clicking on Convert Selected button, an alert ‘Some files require Adobe 4.

InDesign to be launched. Please ensure that Adobe InDesign is not used while this 

process is running’ will be displayed.  
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The results will be displayed at end of the conversion process. A user can 5.

navigate to the destination folder by clicking on the converted QuarkXPress 

files in this dialog.  
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Note: 

To convert InDesign (INDD) files, a copy of InDesign should be installed on •

a customer machine. 

Table Styles Enhancement in IDML Import 

In the earlier builds of IDML import, we only supported basic table import without 

any styling and formatting. In QuarkXPress 2019 (v15.1), we have mapped table 

styling. All the applied table styles and local formatting can be imported properly 

during IDML Import in the QuarkXPress project. 

Properties applied through table style will be mapped in Table styles with the •

same name into QuarkXPress. 

Cell style applied independently in InDesign mapped as locally. •

Current Limitations/Defects 

Some continued or long table’s content might be displayed overflown. •

Some features in InDesign for Row, Stroke, Fill (Skip First, Skip Last, Alternate •

Row & Column) are not mapped. 

How to use it? 

Import IDML file having different table styles. 1.

Create different table styles in IDML file and import in QuarkXPress 2019 2.

(v15.1). 
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Apply different types of local formatting on Tables and import in QuarkXPress 3.

2019 (v15.1). 

Design Features 

  

Integration of Custom Border Styles with Item Styles and Item 
Find/Change 

Custom Border Styles in Item Styles: QuarkXPress 2019 (v15.1) allows you to set 

the custom border styles (dashes and stripes) in Item Styles. You can now save an 

item style with a custom border and use that item style across projects. 

 

Custom Border Styles in Item Styles 

Custom Border Styles in Item Find/Change: Now a user can find and replace the 

custom border style through Item Find/Change palette. 
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Custom Border Styles in Item Find/Change 

Integration of Auto Grow Text Boxes in Item Styles 

Auto Grow in Item Styles: QuarkXPress 2019 (v15.1) allows you to set the text box 

dimensions to auto so that the box grows automatically as you type. 
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Auto Grow in Item Styles 

Integration of Heterogeneous Borders in Item Styles 

Heterogeneous Borders in Item Style: QuarkXPress 2019 (v15.1) allows you to 

create an item style with heterogeneous border where a user can define a different 

border for each side of the box. Drawing order for heterogeneous border can also be 

set in Item Style. 

 

Heterogeneous Borders in Item Style 
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Tables 

  

Improved Integration with Master Pages 

How to use it?  

Tables created on Master Pages work better now. The enhancements for Table Styles 

are now fully supported for Tables on Master Page as well. You can anchor Tables 

inside text boxes on Master Pages, and they will work on layout pages as well. 

Continued Table Headers 

How to use it?  

Continued Headers work better in QuarkXPress 15.1. You can apply Continued 

Headers on both stand alone tables, and table anchored inside text boxes. 

  

Read more about it here: 

http://www.quark.com/documentation/quarkXPress/2018/english/en-2018-qxp-

guide/_1_3463053208680388E7_5.html#_4D49CF161CF945ABB1533151C113D1C4_

5_9_16 
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Graphics 

  

Enhancements of Color Editing 

  

Auto Color Name 

Prior to QuarkXPress 2019 (v15.1), when we create a new color, the color was 

created with the default name as ‘New Color’ and sometimes the designer wants the 

color names like (e.g. R-200 G-50 B-60 or C10M5Y10K0) or with the names by using 

the color % with an auto name. But there was no option and the user have to enter 

it manually. It was a tedious job to modify the names manually for all the colors. 

To resolve this issue in QuarkXPress 2019 (v15.1), we have the option in the edit 

color dialog as ‘Auto Name’. When you check the option, the name would be 

created as per the color is shown for the color values of the selected color model. 

How to use it? 

Create new colors with the auto name enabled for RGB, HSB, LAB, CMYK 1.

colors. 

Create new colors with the auto name enabled for all the spot color libraries. 2.

Created colors would list in the colors drop down in all the drop-down and the 3.

user can use in the layout and save the project and copy and paste and append. 

Open the legacy projects which are having lots of colors and double-click the 4.

colors and check the auto name and verify the colors for the auto name are 

created correctly. 

Editing of the Colors 

Prior to QuarkXPress 2019 (v15.1), if the user wants to edit the color, he has to 

invoke the contextual menu on the selected color and select the option Edit and 

modify the color, or go to edit menu, select the colors, and then select the edit and 

modify the color. It was really painful for the user to perform multiple steps. To 

reduce the time-consuming effort to modify the colors, in QuarkXPress 2019 

(v15.1), we are providing the option (double-click) on selected color to invoke the 

edit color dialog and the user can simply edit the color on the go. 

How to use it? 

Select the editable colors and double-click it. The edit color dialog would 1.

invoke. 

Select the non-editable colors and double-click it. The duplicate dialog would 2.

invoke. 

The user can use all the color libraries, colors with undo and redo. 3.

Open the legacy projects which are having lots of colors and double-click the 4.

colors to view the color editing. 
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Improvements in EPS Images 

On importing EPS images, which is having text with embedded fonts were getting 

rendered and outputted with Courier fonts, due to some permission issues. Now all 

such issues are fixed and the user should be able import EPS images having 

embedded fonts, rendering, and output from QuarkXPress. 

Spring Loading Progress Bar 

When we implemented the spring loading feature prior to QuarkXPress 2019 

(v15.1), during the spring loading of the contents (images/text files), the application 

used to show the spin ball and sometimes the user feels the application is not 

responding. To avoid this in QuarkXPress 2019 (v15.1), we have implemented the 

progress bar to show what is actually happening during the spring loading. In the 

progress bar, the status would be shown for the files which are getting loaded into 

the cursor. Once the files are loaded into the cursor, the user can drop into the 

layout or selected box. 

How to use it? 

Select multiple text files or images and import and verify the progress bar. 1.

Select multiple text files or images and drag and drop into the layout and verify 2.

the progress bar. 

Cancel the progress and observe the contents are loaded and the operation is 3.

canceled and the rest of the contents are not loaded into the cursor. 

Digital Publishing 

  

Flex Layouts 

  

Hyperlinks Support  

When we implemented hyperlinks for Flex Layouts in QuarkXPress2019, we 

allowed applying hyperlinks only onto the text. But now you can apply hyperlinks 

even on a box, including Text Box, Picture Box, None Box, Group box and Flex 

Container box. 

Usability Enhancements 

  

There are several usability enhancements that we have done for Flex Layouts. 

Improvements in Paste 
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Now, you can copy any flex item from one container and paste it directly into the 

second container by using paste options. Whereas in the earlier version, if the user 

wants to copy any flex item from one flex container to another container, he had to 

copy-paste it from the first flex container and then had to explicitly attach it to the 

second container.  

  

You can also paste a flex item before or after any selected flex item within the flex 

container by using the Paste Before and Paste After menu options. 

Changing the flex item order 

  

In the earlier version, the only way to change the order of a flex item within a 

container was to drag out that flex item and insert it again at the desired location. 

Now, you can rearrange child items within the flex container by using Shortcut keys 

(Ctrl or Command Up/Ctrl or Command Down) or Move Up, Move Down menu 

available in Item Menu. 

Adding Layout Blocks by double-clicking them 

  

You can add Layout Blocks on a layout by simply double-clicking them in the 

Layout Blocks Palette. They will get attached to the selected container box 

automatically if any container box is selected on the layout or else layout blocks 

will be placed on the layout. 

Default Color Profile for Digital Layouts 

As per W3C recommendations, all the browsers are supposed to use sRGB profiles in 

case images used do not have any profile embedded into them. To have WYSIWYG 

experience, we have set the default source setup to be “QuarkXPress Digital Default” 

in all Digital Layouts, that uses sRGB color profiles. Now QuarkXPress will render 

images in the same way as being rendered in the browsers. Apart from this, by 

default, some RGB colors are added in the color palette for Digital Layouts. 

Object Browser 

No more difficulties in selecting boxes in nested containers. This new palette allows 

you to select and move around objects with ease. 
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Object Browser 

Usability Improvements 

  

Palette Sets and Usability Issues 

Prior to QuarkXPress 2019 (v15.1), when we use the palettes, there were issues like 

some palettes were opened in the small or large size. When palettes are docked and 

undocked, the size and positions are not retained due to which when the user re-

invokes the palettes, he needs to readjust the palettes. Sometimes the scrolling did 

not work. Due to the above issues, the user needs to re-adjust or invoke the 

palette/sets. In QuarkXPress 2019 (v15.1), we have addressed these usability issues. 

What is it? 

Improvements in docking and undocking of the palettes. 1.

Improvements in resizing the palettes. 2.

Improvements in closing and reopening of the palettes. 3.

Improvements in scrolling down/up in the palette sets. 4.

Palettes or Palette Sets flickering issues have been resolved. 5.

Issues related to the overlapping of the palette have been resolved. 6.

Performance improvements in the loading of the palettes.7.
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Features and Enhancements 

This document provides an introduction to new features and enhancements in 

QuarkXPress 2019 (v15.0.1). 

Text and Typography •

Applying font styles •

Text and Typography 

  

Applying font styles 

In QuarkXPress 2018, the font style user interface was enhanced. Now, there was a 

separate font family and font style menu on both Win and Mac. The user was able 

to choose the desired font styles from the font style menu. The Plain, Bold, Italic 

buttons were not removed in order to retain the legacy behavior. Furthermore, the 

buttons were mapped to the font styles (i.e. the buttons indicated the font faces). 

On selecting a font style, its corresponding font face/ button would be selected. On 

clicking the button, a font style corresponding to the font face would be selected 

from the font style menu. 

But, many of the font families had more than a single font style which mapped to 

the same font face like Bold, SemiBold, Condensed Bold, Heavy, Black font styles 

which map to Bold. In such cases, if the user clicked the bold button to apply bold 

styling, there was no standard mechanism to identify which of the bold face font 

styles should be selected. Likewise, on clicking on the Bold button to remove bold 

styling, there was no standard mechanism to identify which of the plain face font 

styles should be selected. This behavior created a lot of confusion for the users. 

  

It was not possible to add buttons for each of the font styles as the font families 

could have numerous font styles (Example: The Kepler Std font family has 168 font 

styles). Multiple clicks on a single button to select the desired font style was also not 

a feasible solution. 

In order to address these issues and to have a more predictable user interface, the 

Plain, Bold and Italic buttons have been removed from the user interface in 
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QuarkXPress 2019- version 15.0.1. Now, the user has to change the font style from 

the font style menu. In order to retain the legacy behavior for the users who applied 

font style through key commands, the key commands to apply bold/ italics have 

been retained. 

In previous versions of QuarkXPress, the key commands to apply bold and italics 

would work even if the applied font family did not have a font style with an 

intrinsic bold or italic font face. In such cases, faux bold or faux italics would get 

applied on the text. The application of faux bold/ italic is not considered preferable 

for designing. 

 

Home Tab 

  

 

Character Tab 

In QuarkXPress 2019, version 15.0.1, the font styling behavior has been changed. 

On pressing the key command to apply bold/ italic style, if the font family has a 

font style corresponding to that font face, then the font style will be selected, 

otherwise, the key command will be ignored. 

If the key command to bold/ italic style is being ignored/ is not working, kindly 

check if the applied font family has a font style corresponding to that font face 

(bold/ italic). 

In previous versions of QuarkXPress, in case of small font families that only had a 

Regular, Bold, Italic, Bold Italic, it was easy to use a key command to apply bold/ 

italics. In case of large font families which have many sub font families like Light, 

Light Italic; Medium, Medium Italic; Condensed, Condensed Bold, Condensed 

Italic, Condensed Bold Italic; Regular, Bold, Italic, Bold Italic, it was not easy to use 

key command to apply bold/ italic as the application was not aware of which bold/ 

italic style to choose. In addition to that, if a bold/ italic style was not available in a 

sub font family, the shortcut would select a bold/ italic style of another sub font 

family (from within the large font family). Hence, if the Condensed Bold font style 

was not available, the shortcut would select the Bold font style. This was not a 

correct behavior since applying a bold/ italic font style of a sub family would alter 

the current font-weight/ width. 

In QuarkXPress 2019, version 15.0.1, the font styling behavior has been changed 

with respect to key commands. In large font families, while applying bold/ italic 

styling through key command, it will only search for the bold/ italic style from 

within the current sub font family. If the sub font family has a font style 

corresponding to that font face, then the font style will be selected, otherwise, the 

key command will be ignored. The key command will no longer select a bold/ italic 

font style outside the current sub font family. 

It is recommended that the user should use the font style pop-menu to select the 

desired font styles. 
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Handling faux styles in QuarkXPress 

In case faux styling is applied on the text, it will be displayed as [Faux Bold], •

[Faux Italic], [Faux Bold Italic] in the user interface. 

 

Faux Styles 

  

While opening a previous version document in QuarkXPress 2019, in case faux •

styling is applied on the text, then faux style string will be displayed in the font 

style field. 

While importing a text file having faux styling applied, then faux style string •

will be displayed in the font style. 

While changing a font family in the font menus (measurement palette, Style •

sheet, Rubi dialog, Usage Font Replacement dialog), if the current font has a 

bold/ italics/ bold italics font style applied, but the same is not available in new 

font family being applied, then an appropriate faux style string will be applied. 

Faux style string is dynamically populated in the font style pop up. It is only •

available in the font style pop up menu.  

Faux style string is not available font family sub-menu. If a faux style is applied, •

then all the font styles in the font family sub menu will display as unchecked. 

If the faux styling is applied as local formatting, it is preserved on updating the •

style sheet. 

If the user changes the applied font style in case of faux style, then the faux style •

will not available in the font style pop up to the user. But, if you undo the style 

change action, the faux style will be reverted back. 

Faux styling applied on the text is preserved on copy-pasting and drag-drop text/ •

text boxes within the same project and across projects; on appending layout and 

on appending style sheet having the faux style applied. 

Similar to the behavior in previous versions, an alert will be displayed on •

flattened output if transparency is applied to the text with faux styling. 

Faux styling is preserved on enabling any other font family or font style other •

than the current applicable font style. The faux style will be removed if the 

actual font style is enabled thereafter. 

In case, you wish to change the default faux style settings and apply faux styles, 

kindly quit the application, go to QuarkXPress application folder on Windows; 

while on Mac, you need to Mac HD/ Users/<current user>/Library/Application 

Support/Quark/QuarkXPress 2019 > Go to Settings.xml file and edit it. 
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<FontStyleSettings AllowFauxStyles="false"> 

</FontStyleSettings> 

Change the value of ‘AllowFauxStyles‘ from ‘false’ to ‘true’, then save the file. 

Now, relaunch the application. 

Font styles in Usage dialog 

The display of font styling information the Usage dialog has also been changed in 

QuarkXPress 2019, version 15.0.1. The font face displayed in angular brackets has 

been removed if font is available on the system. 

Now, only the font name is displayed in Usage dialog > Fonts tab if the font is 

available on the system. 

Example: 

Myriad Pro Regular 

Myriad Pro Bold 

Myriad Pro Italic 

Myriad Pro Bold Italic 

In the case of missing fonts, the font face is displayed in angular brackets along with 

the missing font name. 

Example:  

Georgia Pro Italic displays as (-5, Georgia Pro) <<Italic>>  

Avenir LT Std Heavy displays as (-3, Avenir LT Std 65 Medium) <<Bold>> 

In case, faux bold/ italic styling is applied on the font, the faux bold/ italic string is 

displayed alongside the font name within square parenthesis. Also, a faux warning 

icon is displayed on the left of the font name.
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QuarkXPress 2019 (v15.0) 

Features and Enhancements 

This document provides an introduction to new features and enhancements in 

QuarkXPress 2019 (v15.0), including: 

Design Features •

New Table Model with Table Styles •

9-Point Reference Grid •

Auto Grow/Shrink Text Boxes •

Spring Loading on Cursor •

  

Graphics •

PDF/UA •

PDF/A Export enhancement •

Export as Image enhancements •

  

Text and Typography •

Paragraph Alignment enhancement •

Paragraph Formatting enhancement •

  

Digital Publishing •

Flex Layouts •

  

User Interface •

Easy Access to Merge/ Split Shapes •

Enhanced Icons and Cursors •

  

Miscellaneous •



QUARKXPRESS 2019 (V15.0)

Performance Improvements •

Design Features 

New Table Model with Table Styles 

Formatting tables in QuarkXPress has been time-taking and required repetitive 

efforts for each table you inserted in a document. The table grid formatting options 

were limited to rows and columns with no option for cell level border and shading. 

QuarkXPress 2019 (v15.0) introduces a new table model, offering brand-new table 

features with an intuitive new user interface for formatting tables and creating table 

styles. 

In Table Styles, you can now capture newly introduced styling rules for the table, 

row, column and cell-level formatting along with text styling rules. (in previous 

versions, table styles support was limited to Inline tables linked to Excel tables 

only). With the new table model, you can now apply Table Styles to any table 

created in QuarkXPress directly or imported from an Excel source. 

QuarkXPress 2019 (v15.0) offers table formatting presets (predefined table styles) for 

various formatting options as a starting point to create custom table styles. 

The new Measurements Palette UI offers much finer control over formatting Tables 

at the cell level. 
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Table Styles palette 

The table styles palette (Window->Table Styles) allows you to apply a table style to 

the currently selected table, to create a new table style, to apply a preset table style, 

or to edit an existing table style. 

Table styles can also be edited, created or deleted using the “Edit Table Styles” dialog 

(Edit->Table Styles). 

 

Edit Table Styles 

The user interface for creating or editing a table style is divided into sections 

allowing you to specify table properties, row properties, column properties, and cell 

properties. 

Selecting an option in the column on the left-hand side of this dialog will allow you 

to specify the properties that are specific to the selected context. For contexts where 

there are multiple possible options: such as columns and rows - where you can 

select, for example, header row, all odd rows, all even rows, or footer row, and 

specify different properties for each - a list is displayed at the top of the dialog, 

allowing you to choose a more specific context.  

For each selected context (table, row, column, etc.), you can set the border and fill 

properties, text properties (for text cells in that context) and picture properties (for 

picture cells within that context). 
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Edit Table Style _ Border and Fill Tab 

 

Edit Table Style _Text Tab 
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Edit Table Style _Picture Tab 

 

Edit Table Style _ Row pane 

 

Table Tab _ Measurements palette 
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Cell Tab _ Measurements palette 

 

Create Table from External Source _ Table Menu 

You can import tables from external sources, such as a Microsoft Excel spreadsheet, 

and apply a table style to that imported table. 

 

Table Link 

When importing a table from an external source, you can browse to the location of 

the source document, select the worksheet containing the table you wish to import 

and select the range of cells to import.  

You can select to include the text and table formatting already included in the 

source document (“options->include formats”), and the column widths/row heights 

(“options -> include geometry”): you can also choose whether to hide or show any 

rows or columns that are hidden in the source Worksheet. 
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You can specify how many rows of the table should be considered header rows 

(“Header Rows”), whether the box will expand to fit the table (default) or whether 

the table will be resized to fit the box (“Fit to Box”), and which table style to apply. 

You can choose to import a Table along with its style from MS Excel. Simply select 

the Excel Table from the “Range” field, and let the “Table Style” drop-down to be 

“Inherit “ and import. 

 

Table Break Properties 

 

Table Properties dialog 

Easy access to table formatting features directly from the 
measurements palette 

Measurements palette to offer local formatting on Home tab •
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Contextual to selection — cell, rows, columns or combination for •

formatting a selection 

Set border and fill for selected cells •

Dedicated control in the measurements’ palette to set Grid / Frame properties. •

Dedicated Table and Cell Tabs in the measurements palette, even when you are 

working on the cell’s content. New User interface/experience for Table Styles. 

New Features 

Simplified Table Properties (Table Creation) dialog with new options to add Table •

Header/Footer 

Support for cell level grid formatting •

Consolidation of Inline and Design (legacy) tables •

Access to a wider range of table properties through the measurements’ palette  •

Support for Table Header and Footer (previously, selecting header rows was •

supported only when the table breaks across the pages). Now header and footer 

rows can be defined for stand-alone tables as well, without applying Table Break 

properties. 

Table Styles to support - •

Easy to use, flexible and comprehensive formatting rules •

An intuitive user interface to set table and column/row/cell level bordering •

Set the percentage of column width that an anchored table will occupy •

Line drawing order for table borders •

The new set of formatting rules when compared with legacy table styles •

Rules specific to Column, Row and Cell level formatting •

Table Style Presets •

Presets for table border and shading styles •

Duplicate presets to create your own table styles •

Support for Text and Picture formatting in cells •

Support for Multiple Insets for text in addition to Paragraph Styles •

Picture formatting to support new fitting rules in addition to other picture •

content transforms, scaling, etc. 

Import Excel tables using new Tables Styles (not supported before for legacy •

table model) 

9-Point Reference Grid 

A big benefit that QuarkXPress has always had is the ability to specify the 

positioning of objects precisely by entering coordinates in the measurements palette 

- allowing objects to be precisely aligned at specific locations. A feature commonly 

requested by designers is the ability to define the position of page elements using 
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different reference points, e.g. change the reference point to the lower right corner 

instead of using top left corner as default, when you do this, the coordinates 

displayed in the measurements palette will adjust to be relative to this point. 

When you resize a box using width and height settings on the measurements 

palette, it always grows to the right and bottom of the page. The new 9-Point 

Reference Grid option in the measurements palette will allow you to change 

reference point for all the nine points referred which include a center point: when 

you then resize the box, it will resize relative to the selected point. 

 

9-Point Reference Grid in the measurements palette 

  

 

9-Point Reference Grid during box rotation 

  

How it works 

On the measurements palette, you can select any of the 9-reference points as •

indicated. 

Once you set a Reference Point, all boxes in that particular layout will work with •

respect to the selected reference point. On creating a new project, the reference 

point will be reset to the ‘Top Left’. 
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Previously, when you rotated an object either manually or by using a mouse, the •

object rotated from the center. In QuarkXPress 2019, the box will rotate from 

the selected Reference Point. 

Auto Grow/Shrink Text Boxes 

QuarkXPress 2019 (v15.0) introduces a new text box property to let the box grow or 

shrink automatically during text input, text import/ text copy-paste/ drag and drop 

text. This feature adds huge benefits for the designer since they now do not have to 

keep dealing with the text over matter or keep readjusting box to fit the text length. 

Users can set text box width, height or both to auto. A text box can auto-grow up to 

the page margin (width-wise and height-wise). Auto (grow/shrink) property is only 

applicable for rectangular text boxes and will be turned off in case of non-

rectangular boxes, boxes having text angle or text skew. 

 

  

 

Auto grow values defined in measurements palette 

  

How it works 

You can now set Width/Height of box to Auto or Fixed through measurements •

palette. 

Spring-Loading on Cursor 

QuarkXPress 2019 (v15.0) introduces support for “spring-loading” of images and 

text on the cursor. This allows you to select multiple files (picture or text) at one 

time, and then place them into the layout one after the other - either into existing 

boxes or creating new boxes dynamically - without needing to return to the Import 

dialog. 
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Spring-Loading Images 

  

 

Spring Loading Text Files 

  

How it works 

In the import dialog, you can select multiple images or text or combination of •

images and text files to import. 
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The cursor will change to show you a thumbnail of the next file to place, and a •

counter showing how many more files are waiting on the cursor to place; 

allowing you to click onto the document page and place them as desired. 

You can import into an existing box by clicking on it, or create a new box - •

which will be created according to the image size for pictures, or between the 

margins for text boxes - by clicking onto an empty area of the page. 

You can drag and drop files onto document canvas to spring load the files onto •

the cursor. 

You can replace the image/text by pressing the Command+Shift or Ctrl+Shift •

and click on the box. 

You can cycle through the images/text by using the arrow keys on the keyboard. •

The user may append to existing text box content by using Cmd+Shift or •

Ctrl+Shift key and click in between the story, the story will flow from the clicked 

location. 

Users may add additional items to spring-loaded cursor by selecting additional •

files in the import dialog. 

You can have a different spring-loaded cursor for different layout or project. •

When you drag and drop a text file to a QuarkXPress layout, a new text box will •

be created automatically and it will always fit within the page margins. 

When the user drops into a box irrespective of whether it has any existing •

content or not, it will create a new box above the existing box and image/text 

will be placed in it. It will not replace the existing content. 

When the user drops the image into other box types (none/text), it will create a •

new box and place the text/image in the newly created box. 

Users can remove spring-loaded items from the cursor by the Escape key. •

You can undo and redo the placement of images and text dropped through •

spring loading cursor. 

The thumbnail preview is only available for images in this version of 
QuarkXPress. 

In case you want to use the legacy Drag and Drop behavior, you need to press 
the Shift key while dragging the image/ text file. 

Graphics 

Tagged PDF (PDF/UA) 

In recent days, the digital publishing practices emphasize the importance of 

Accessibility support. There has been demand from the corporate and government 

organizations, in response to legislation such as the Americans with Disabilities Act, 

and section 508 of the Rehabilitation Act of 1973. As a result, industry standards, 

such as WCAG  have been introduced, to allow the accessibility of information in 

published forms (both PDF and websites containing HTML output), to be certified, 

ensuring that the published information is equally accessible to consumers with 
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disabilities that every PDF published must be accessible. QuarkXPress introduced 

tagged PDF already in previous releases, and now it enhances the capabilities to 

produce PDF/UA standard. QuarkXPress 2019 (v15.0) offers export to PDF with 

compliance for PDF/UA (ISO 14289) and WCAG 2.0 standard. 

 

PDF/UA 

  

How it works 

You can now select the PDF output option to conform to the PDF/UA standard •

as shown above. 

PDF/A Export enhancement 

PDF archive standards were equally desired by many governments and corporate 

organizations. We introduced PDF/A-2b and PDF/A-2u in earlier versions and now 

we enhance PDF/A support to include PDF/A-3a and PDF/A-2a standards. 
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PDF Style 

 

PDF Verification 

  

  

 How it works 

You can now choose between any of the PDF/A validations that are supported by •

QuarkXPress. 
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Export as Image enhancements 

In QuarkXPress 2019 (v15.0), the Export as Image feature has been enhanced to 

now support exporting in a higher resolution (previous versions only allowed 

export at 72ppi) and exporting to different file formats. 

QuarkXPress 2019 (v15.0) now also allows defining presets for exporting as an 

image; and pushes image export to a new limit: High-quality, color-managed image 

export for print and digital use, allows marketers and web designers to create 

stunning images in JPEG, TIFF and PNG and PDF (Raster) formats that resemble the 

quality of QuarkXPress layouts. 
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How it works 

Export as an image now includes PDF raster in addition to JPEG, TIFF and PNG •

formats 

To export an image, select File->Export as image, and select the file format which •

you wish to export to (JPEG, PDF, TIFF...) 

When you select the export option, you will be presented with a new dialog •

with additional export options. 

The new export options include embedding color profile (which is defined in the •

source setup for RGB) 

You can now save Image Export Styles as an additional type of “Output Style”, •

allowing you to define a reusable set of image export parameters 

You can assign a bleed value for the image export (symmetric and asymmetric) •

You can open the exported image once the export is completed in the default •

application defined at the OS level. 

Export Settings will be retained on the layout after save and reopen. •

Transparent background export option is available for PNG and PDF. •

Text and Typography 

Paragraph alignment enhancement 

For facing pages documents, there was no easy way to set the text alignments to 

follow the spine- requiring that different paragraph styles were defined for recto and 

verso pages and many users requested for an option in paragraph style to let text-
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align towards the spine or away from the spine. QuarkXPress 2019 (v15.0) 

introduces these options as part of paragraph alignment enhancement. 

How it works 

You will find the following new text alignment settings in the paragraph style sheet 

and measurements palette: 

Towards Spine •

Away From Spine •

Text alignment changes in case of Towards Spine and Away from Spine are visible in 

case of a facing-page layout. 

 

Towards Spine alignment 

 

Away From Spine alignment 
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New alignment options in Paragraph Style Sheet 

  

In the case of Facing Pages, there is a spine: 

Towards Spine alignment: Irrespective of the number of pages in the spread, the •

text on all the Left side pages will align to the right side (i.e. towards the spine); 

the text on all the Right side pages will align to the left side (i.e. towards the 

spine). 

Away from Spine alignment: Irrespective of the number of pages in the spread, •

the text on all the Left side pages will align to the left side (i.e. away from the 

spine); the text on all the Right side pages will align to the right side (i.e. away 

from the spine). 

In case of Non- Facing Pages, there is no spine: 

Towards Spine alignment: Irrespective of the number of pages in the spread, the •

text will align to the left side. 

Away from Spine alignment: Irrespective of the number of pages in the spread, •

the text will align to the right side. 
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Paragraph formatting enhancement 

Many users had been requesting an option to define the Space between consecutive 

paragraphs having the same paragraph style sheet applied. Prior to QuarkXPress 

2019 (v15.0), whenever user-defined Space Before and Space After in a paragraph 

style sheet and the same style sheet was applied on consecutive paragraphs, then 

both the spacing would get applied on the consecutive paragraphs. In such cases, if 

the user wanted to ignore the spacing between consecutive paragraphs, he had to 

locally select the paragraphs and edit the spacing values. 

QuarkXPress 2019 (v15.0) includes a new Space Between option to help define the 

space between consecutive paragraphs having the same paragraph style sheet 

applied; using this option you can ignore the spacing or define a custom spacing 

value for such paragraphs. This feature particularly applicable when creating a Table 

of Contents and bulleted/ numbered lists. 

 

Space Between set to ‘Ignore’ 
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Space Between set to ‘0’ 

  

How it works 

You can now ignore or apply different spacing between consecutive paragraphs •

having the same style applied. You may want to apply this when you have 

applied space before or space after or both on multiple paragraphs and want to 

ignore or customize the spacing between consecutive paragraphs. 

To apply Space Before/ Space After on consecutive paragraphs having the •

same style sheet: Select ‘Ignore’ value in Space Between 

To ignore the spacing between consecutive paragraphs having the same •

style sheet: Set value to 0 in Space Between 

To reduce the spacing between consecutive paragraphs having the same •

style sheet: Define any custom value in Space Between 

Space Between attribute can be imported from Microsoft Word files, RTF files, 
XPress Tags files and can also be exported from QuarkXPress to any of these 

formats. 

Digital Publishing 

Flex Layouts 

Modern Digital Publishing is embracing responsive HTML5 for web and mobile 

publishing. It also demands to support or comply with progressive web app (PWA) 

standards so that users are benefited native app-like experience on the web. Over 

the past years, QuarkXPress delivered digital publishing capabilities from eBooks to 

HTML5 Publications and then iOS/Android app export straight from QuarkXPress. 
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Now, QuarkXPress 2019 (v15.0) introduces new tooling to responsive HTML5 

output, with the compliance for PWA standards. 

QuarkXPress 2019 (v15.0) adds a new layout space called Flex Layouts with 

additional tooling to design response designs in a WYSIWYG environment without 

any HTML or CSS coding skills. The Flex designs can be previewed at run time for 

different device screen sizes without leaving the application or exporting to HTML 

output to view in the browser. The HTML output from such layouts is truly 

responsive to any device aspect ratios including desktop screen ratios. 

The new tooling introduced for Flex Layouts is still familiar for existing print 

designers, without a steep learning curve. Furthermore, if you are familiar with web 

designing and CSS Flex properties, you do not need to learn a new vocabulary, as 

QuarkXPress 2019 uses CSS Flex properties and terminology, for creating responsive 

layouts, ensuring that graphic designers and web developers working on the same 

project can communicate using the same terms when discussing Flex layouts. 

You can now build responsive HTML designs from simple banner ads to micro 

websites and responsive HTML5 publications for your customers. 

 

Flex Layout 
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Flex Layout — In-app preview for a small device 

  

 

Grid Settings — New Project Dialog for Flex Layout 
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Features 

New Flex Layout space 

New project dialog for Flex layouts •

Support Grid size, instead of fixed pages or devices •

Support for Root Container •

Master Page support — master page link breaks only when content is changed; •

allows you to create consistent responsive HTML5 pages, based on a common 

layout template, just as you would for a print document - ensuring consistency 

across pages. 

Document Window 

Responsive canvas •

Column Grid view •

Layout elements snap to columns/grids •

WYSIWYG view — Responsive behavior to help the designer to “view as you •

design” 

New Container Box 

Automatic grouping of contained elements •

Rule-based layouting for child elements •

Containers that support background color, background image, background •

video, etc. 

A new palette for “Layout Blocks” 

Pre-build configurations/structures for Layout, Sections, components and Basic •

text/picture blocks. 

Special wrapped Picture and Text boxes with desired padding/margins suitable •

for responsive behavior on the web 

New dialog to control different aspects of these layout blocks, such as default •

padding for text and picture boxes, row sizes, container sizes, responsive break 

points for different components, etc. 

Layout blocks not only provide the ability to create web publication but also •

provide the building blocks for creating a consistent document structure. 

No bindings with layout blocks — Though you don’t have to define all the •

properties for any of the components, you still have control to change or play 

with any of the defined properties of the component to suit your needs. 

Path control allows the user to inspect the selected box’s parent hierarchy •

Hovering over any box token within this parent hierarchy will highlight the •

actual box on canvas, there by identifying each box individually 

It also provides appropriate hints of the responsibilities for each ancestral •

box 

Tool 
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Introduces new tool for creating Flex Container  •

Enhanced Measurements palette 

New Tabs •

Container — Flex Container •

CSS Properties supported - display, flex-direction, flex-wrap, flow-flow, •

justify-content, align-items, align-content 

Flex — Flex items •

CSS Properties — flex-grow, flex-shrink, flex, align-self •

Box dimensions can be specified in flexible units like % •

Auto grow/shrink can include constraints like min/max height and width •

Integration 

Ability to define in Item Styles •

Ability to save Flex layout items to a library •

Ability to use Item Picker Tool with Flex layout items •

  

Enhanced Text/Image Boxes 

Auto grow/shrink text boxes •

With the ability to apply constraints like min-max height and width •

Text/Image content effects 

Auto resize picture content (keeping crop area intact) •

Picture Fitting Modes for picture box and container background — Cover (Fill), •

Contain (Fit), Stretch, Scale 

Output 

Formats supported: •

Responsive HTML page •

Responsive HTML Publications •

Support for Parallax Effect — background container •

Vector shapes created in QuarkXPress are exported as SVGs •

Native HTML export of drop shadow, blends, blend modes, gradients, •

typography 

Can include micro-designs with Fixed HTML designs (Grouped elements) •

New Output Styles for Responsive HTML5 •

Responsive HTML5 preview in browser •
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Benefits Summary 

Comparing Digital Fixed layouts and Flex layouts 

Fixed layouts are target device size-dependent, whereas Flex can be developed •

deployed onto any device 

Fixed publication needs multiple layout designs for each target device, whereas a •

single Flex layout suffices the requirement for any device 

Flex layouts support multi-level containment hierarchy •

Effects like drop shadow, image effects, blends, etc are backed into images for •

Fixed layouts, but for Flex, they are exported natively as HTML5 equivalents 

Workspace 

Responsive HTML5 — User can now create responsive HTML5 publications •

without writing any code 

Responsive Layouts — ability to see and test responsiveness within the layout •

Design Flex layouts using Grids •

Define your own custom grid by specifying columns, gutters, and grid size •

Design pages with easy to use responsive layout blocks •

Support for drop shadow –– drop shadows are not backed into images, rather are •

exported natively 

Support for Advanced typographic features like leading, kerning, tracking, •

paragraph shading, text shading 

Support for OpenType features •

Ability to create new vector shapes in QuarkXPress, and use them in responsive •

layouts 

Apply gradient and export them natively in HTML5 •

Image Effects –– color correct images within QuarkXPress without needing any •

other software 

Apply HTML5 native Color Blend Modes •

Support for various image fitting options like the cover, container stretch, etc. •

Apply Parallax Effect on background images •

Videos can now be used as backgrounds •

Support for interactive layout elements •

Responsive layouts can be exported to create HTML5 Publications, iOS or •

Android apps 

Integration of Flex properties with Item Styles •

Fixed Layouts 

Previously, you had to convert text box as Graphics to apply drop shadow while 

working with Digital Fixed layouts. This limitation has been resolved in 
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QuarkXPress 2019. Now you can apply drop shadow on text boxes without 

converting text boxes to Graphics. 

User Interface 

Easy Access to Merge/ Split Shapes 

The options to merge and split two or more shapes in QuarkXPress were available 

only through the Item menu. QuarkXPress 2019 (v15.0) adds new tools on 

measurements palette, whose icons graphically depict the merge or split behavior, 

making them more intuitive for designers to easily access and create complex 

shapes with the combination of two or more shapes. 

 

New Merge/ Split Shape icons in measurements palette 

  

How it works 

 Intersection: Keeps only the overlapping areas of the selected items. The •
color of the back-most item is applied to the new single item. 

 Union: Combines all the selected items into one box, keeping both the •

overlapping and non-overlapping areas. The color of the back-most item is 

applied to the new single item. 

 Difference: Removes the overlapped areas from the back item and deletes •

the front-most item from the selected items. 

 Reverse Difference: Removes the overlapped areas from the front item and •

deletes the back-most item from the selected items. 

 Exclusive Or: Leaves all the shapes intact but cuts out overlapping areas. It •

creates two bezier points at each location where any two lines originally 

intersected. It is used to create a ‘see-through’ effect with overlapping items. 

 Split All Paths: Separates the items from each other until every box within •

a complex box has been split. If you use this command on a shape that has a 

hole in it, the hole becomes solid. 

 Join End Points: Two endpoints (one on each path) need to be placed on •

the top (or within 6 points) of each other. Merges the two points into one corner 

point. 
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QUARKXPRESS 2019 (V15.0)

Enhanced Icons and Cursors 

QuarkXPress 2019 (v15.0) enhances many existing icons, cursor, and tools to 

improve the usability of hi-dpi/retina screen displays. 

Miscellaneous 

Performance Improvements 

In addition to improved image cache handling with multi-threading support, 

QuarkXPress on Windows now uses hardware acceleration to give a boost to 

graphics performance. While this improves overall image handling faster it also 

makes layout operations like scrolling, panning, Image Editing, and many other 

operations faster for image-heavy documents.
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Legal notices 

©2022 Quark Software Inc. and its licensors. All rights reserved. 

Quark, the Quark logo, QuarkXPress, and QuarkCopyDesk are trademarks or 

registered trademarks of Quark Software Inc. and its affiliates in the U.S. and/or 

other countries. All other marks are the property of their respective owners.
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